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Unit 19: Road Map (VERBAL)

Nationally Representative Sample of 7,800 8th Graders Surveyed in 1988 (NELS 88).                           

Outcome Variable (aka Dependent Variable):                      

READING, a continuous variable, test score, mean = 47 and standard deviation = 9

Predictor Variables (aka Independent Variables):                

Question Predictor-

RACE, a polychotomous variable, 1 = Asian, 2 = Latino, 3 = Black and 4 = White       

Control Predictors-

HOMEWORK, hours per week, a continuous variable, mean = 6.0 and standard deviation = 4.7                      

FREELUNCH, a proxy for SES, a dichotomous variable,  1 = Eligible for Free/Reduced Lunch and 0 = Not

ESL, English as a second language, a dichotomous variable, 1 = ESL, 0 = native speaker of English

�Unit 11: What is measurement error, and how does it affect our analyses?

�Unit 12: What tools can we use to detect assumption violations (e.g., outliers)? 

�Unit 13: How do we deal with violations of the linearity and normality assumptions? 

�Unit 14: How do we deal with violations of the homoskedasticity assumption?

�Unit 15: What are the correlations among reading, race, ESL, and homework, controlling for SES?

�Unit 16: Is there a relationship between reading and race, controlling for SES, ESL and homework?

�Unit 17: Does the relationship between reading and race vary by levels of SES, ESL or homework?

�Unit 18: What are sensible strategies for building complex statistical models from scratch?

�Unit 19: How do we deal with violations of the independence assumption?
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Unit 19: Road Map (Schematic)
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In-Class Project
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Fit and interpret this multilevel regression model:

Repeated Measures Outcomes: READING88 READING90 READING92

Predictor: RACE (ASIAN, BLACK, LATINO, WHITE)

Fit and interpret a repeated measure ANOVA model:

• We will do this step-by-step together in class.

• We will restructure the data set together step-by-step in class.

• You will dummy code the variables by yourself but with as much help as you need. 

• You will fit the model by yourself but with as much help as you need.

• We will interpret the results together step-by-step in class.
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Unit 19: Funky Research Question 

Theory: One group reads better than the other because…

Research Question: On average in the population, does Group 1 score higher on the 

reading test than Group 0?  

Data Set: NELS (National Education Longitudinal Study) (n = 11856)

Variables:                                                      

Outcome: (READINGL) IRT Scaled Score on a Standardized Reading Test

Question Predictor: (FUNKYVARIABLE) A dichotomous variable indicating membership 

in one of two groups, Group 1 (FUNKYVARIABLE = 1) or Group 0 (FUNKYVARIABLE = 0)

Model: εββ ++= BLEFUNKYVARIAREADINGL 10

We are going to answer this funkily abstract 
research question using the tools that we 
know and love. There is nothing new in this 
section. What makes this research question 
funky is my withholding of the meaning of 
FUNKYVARIABLE. If you get confused, you 
can replace in your mind FUNKYVARIABLE
with FEMALE. So, instead of thinking about 
Group 1 and Group 0, you can think about 
females and males.
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Exploratory Data Analysis
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Answering the Question Using Regression

On average in the population, Funky Group 1 
tends to score higher than Funky Group 0 on the 
IRT scaled reading test, t(11854) = 22.93, p < 
.001.  Based on 95% confidence intervals, we 
conclude that, in the population, the average 
score for Funky Group 1 (M = 52.0) is between 
3.5 and 4.2 points higher than the average score 
for Funky Group 0 (M = 48.2). 
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Answering the Question Using t-tests

t-test Output
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Answering the Question Using ANOVA

ANOVA Output
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Important Observations/Reminders

Note that the F
statistic is simply the 
square of the t
statistic (in simple 
linear regression).

The intercept (aka, constant) is going to play 
a very important role in things to come. 
Recall that the intercept is the mean of our 
reference category. 
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Thinking More Deeply About the y-Intercept

εββ ++= BLEFUNKYVARIAREADINGL 10

Model 1:

The y-intercept is represented by β0, which in turn represents the mean 
of READINGL when all the predictors have values of zero. What does β0
represent when there are no predictors in the model?

εβ += 0READINGL

Model 0:

When there are no predictors in the model,  β0 represents the (unconditional) mean of READINGL.
Recall that in the absence of further information, the mean is our best guess for individuals, but we 
recognize that the guess is in all probability wrong by a certain amount, so we make sure that we 
have an error term in our model, ε.

Variance (i.e., the average squared mean deviation) is a measure of how wrong the mean is as a 
predictor of individuals.
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Output from Fitting the Unconditional Model (Model 0)

Mean READINGL

Standard Deviation

Variance

Sum of Squared 
Mean Deviations

Note that SPSS does not 
allow us to fit unconditional 
OLS regression models, so I 
made this output by hand.
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Output from Fitting the Conditional Model (Model 1)

Mean READINGL
Conditional on 

FUNKYVARIABLE=0

Standard Deviation* 
of the Residuals

Variance* of the 
Residuals

Sum of Squared 
Residuals (i.e., 

Deviations From the 
Regression Line)

In this model, we make 
predictions of our outcome 
conditional on our predictor, 
which is status quo for us.

* Basically
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Checking Assumptions for Model 1: Searching HI-N-LO

• Heteroskedasticity—We can judge by looking at the right graphs.

• Independence—We cannot judge by looking at any 

graphs. We need to understand our sample and our variable(s).

• Normality—We can judge by looking at the right graphs.

• Linearity—We can judge by looking at the right graphs.

• Outliers—We can judge by looking at the right graphs.

But, what is our 
variable?



Unit 19/Slide 14

Riddle Revealed

Funky Question Predictor: (FUNKYVARIABLE) A dichotomous variable indicating membership 

in one of two groups, Group 1 (FUNKYVARIABLE = 1) or Group 0 (FUNKYVARIABLE = 0)

Real Question Predictor: (WAVE) A dichotomous variable indicating the wave in which the 

reading test was taken, the baseline test was taken in 1988, the 8th grade, (WAVE = 0) and 
the follow-up test was taken in 1990, the 10th grade (WAVE = 1).

We have 11856 observations but only 5928 subjects (with two observations per subject, a 

baseline observation and a follow-up observation).

For example, this 
kid and this kid 
are the same kid

Our observations are 
clustered (in pairs); thus, 
our independence 
assumption is violated.

Students Nested in Classrooms

Classrooms Nested In Schools

Schools Nested in Districts

Districts Nested in States

A new (multilevel) way of 
thinking:

Scores Nested in Students

Children Nested in Families

Families Nested in Neighborhoods

Neighborhoods Nested in Cities

Babies Nested in Nurseries

Nurseries Nested in Hospitals

We will learn to handle two 
levels at a time:

“Observations” Nested in “Clusters”
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Independence Schmindependence: Why Care?

Even when a huge sample size 
makes statistical significance a 
foregone conclusion, we still 
want the right standard errors 
for our confidence intervals.

Note the Standard ErrorsNote the Correlations

Mistaking order for 
chaos is no way to 

go about the 
business of truth.

http://onlinestat

book.com/stat_si

m/repeated_mea

sures/index.html
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One Final Riddle Before We Get Started

Riddle: A class of students takes a midterm exam and a final 
exam. The average score on the midterm exam is 78, and 
the average score on the final exam is 92.  What is the 
correlation between the two sets of exam scores? Can you 
say exactly? Can you at least say the direction?

Answer: We have no clue! If you are like me, your intuition 
is that the correlation must be positive, but it could be 
negative. Imagine if all the people who did the worst on the 
midterm exam were jarred into working harder (and 
smarter), so they ended up doing the best on the final exam.  

In this data set (n = 7), there is a perfect negative correlation 
between the midterm scores and the final scores. The means 
are different (M = 78 and M = 92), and the standard deviations 
also happen to be different (SD = 8.6 and SD = 2.2). But, the 
correlation does not care! I teach the correlation coefficient 
as the slope coefficient from the regression of a standardized 
outcome on a standardized predictor. When we standardize, 
we force the means to be zero and the standard deviations to 
be one so that we can compare apples to apples. See Unit 4 
for a refresher. Algebraically, a correlation is the average of 
the products of the z-scores:
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Unit 19: Most Basic Research Question 

Theory: Students improve their reading skills from the 8th grade to the 10th grade.

Research Question: On average in the population, do students improve on the reading 

test from the 8th grade to the 10th grade? If so, by how much do they improve? 

Because this research question is so basic, we have a wide choice of tools: paired samples t-tests, 
repeated measures ANOVA, and multilevel regression modeling. We will try all three in order 
from simple (and least flexible) to complicated (and most flexible).

Data Set: NELS (National Education Longitudinal Study) (n = 5928)

Variables:                                                      

Outcome: (READINGL) IRT Scaled Scores on a Standardized Reading Test

Question Predictor: From the t-test perspective there is no real predictor, just two (paired) 
samples. From the ANOVA perspective there is no real predictor, just a single repeated measures 
factor, a sort of fusion of our outcome information and wave information. However, from the 
regression perspective, we get to think in terms of outcomes and predictors and apply all our 
model building strategies:

(WAVE) A dichotomous variable indicating the wave in which the test was

taken where WAVE = 0 denotes the baseline, 8th grade, 1988 scores and WAVE = 1 

denotes the follow-up, 10th grade, 1990 scores.

Regression Model:
iijijij uWAVEREADINGL +++= εββ 10

Notice the ij subscripts 
and a second type of error 
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Data Set (For Paired Samples t-test and Repeated Measures ANOVA)

This data structure is very familiar to us. 
Rows represent kids. We see that the 
first kid in our data set has 632790 for 
an ID number and scores 51.15 points on 
the 1988 (8th grade, baseline) reading 
test and 70.06 points on the 1990 (10th

grade, follow-up) reading test. Columns 
represent variables. We have an ID 
variable to help us identify kids, and we 
have two test-score variables.

For multilevel regression modeling, we 
will need to restructure this data set into 
a “person-period data set.” But, no 
worries, because SPSS will basically do 
the work for us. For now, however, 
while we work through t-tests and 
ANOVAs, we’ll stay in this familiar 
territory.
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t-test Perspective

Standard errors come in many flavors, but at their core they are just special 
standard deviations; they are standard deviations of sampling distributions.  
The bigger the sample size, the smaller the standard deviation of the 
sampling distribution, so we estimate standard errors by dividing our 
observed standard deviations by the square root of our sample sizes. See 
Unit 6 for a refresher. There are slight twists for different tests, and the 
twist here is that we take into consideration the correlation.

Take some time to work through this. Here is a spot 
where the algebra can be insightful. For example, 
we know that a large sample size is good. See how 
the samply goodness of the size works into the 
equation.

http://onlinestatbook.com/stat_sim/repeated_measures/index.html

Not that when the correlation is zero, the entire -
2r(sx)(sy) is zeroed out, and we end up with a run-
of-the-mill t-test.
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Paired Samples t-tests in SPSS 

T-TEST PAIRS=READING88 WITH READING90 (PAIRED)

/CRITERIA=CI(.9500)

/MISSING=ANALYSIS.

Go to Analyze > Compare Means > Paired-Samples T Test…

Select your first measure and assign it to the Variable 1 
column, and select your second measure and assign it to 
the Variable 2 column (shown).

Click past when you are done, and run your syntax.
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Repeated Measures ANOVA in SPSS

Go to Analyze > General Linear Model > Repeated Measures…

Define your repeated measures factor(s): (1) Give it a 
name. (2) Note the number of levels (i.e., waves, 
measures). (3) Add it. (4) Click “Define.”

Build your ANOVA model. The structure of your within-
subjects variable(s) is all set up from the last dialogue 
box, so all you need to do it plug and play. Click “Paste”
when you are done.

(You may note that there is room to add good old between-subjects 

factors and covariates (i.e., continuous controls).

1
2

3

4
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ANOVA Perspective

GLM READING88 READING90

/WSFACTOR=R88vsR90 2 Simple 

/METHOD=SSTYPE(3)

/CRITERIA=ALPHA(.05)

/WSDESIGN=R88vsR90.

The syntax is fairly simple, and the output should be very 
simple, but SPSS produces a crap load of distracting output. 
Much of the distracting output has to do with the sphericity 
assumption, which you can read about in Chapter 13 of the 
OnlineStatBook.Com. Of the umpteen tables, this is the only 
really important table, and still it’s cluttered with junk. It 
should only be two lines:

We conducted a one-way within-subjects ANOVA to determine whether IRT scales 
reading scores improved from 8th grade to 10th grade in the population of U.S. 
school children of the late ’80s and early ’90s. We observe a statistically 
significant F value,  F(1, 5927) = 2508.04, p < .001, partial η2= .28. A comparison 
of means suggests that students on average improved 3.83 points from the 1988 
8th grade reading test (M = 48.15 , SD = 8.38) to the 1990 10th grade reading test 
(M = 51.98, SD = 9.75).

As always with ANOVA, we 
need to use planned contrasts, 
graphical plots, post hoc tests, 
and other options to get the 
juicy details.

Recall that the F statistic is the 
square of the t statistic. The t 
statistic from our paired 
samples t-test was -50.08. 

-50.082=2508.043

In ANOVA, the correlation gets 
worked in through the mean 
squares. (And, that’s all we 
really need to know.)



Unit 19/Slide 23

Regression Perspective

Model 1:

This looks very much like the regression models with which we have been working all along the 
way. The only differences are that now we have ij subscripts and a second error term. In the next 
few slides, we will examine the two differences and their implications.

iijijij uWAVEREADINGL +++= εββ 10

Note that the subscript issue is really just a picky detail, but I want to emphasize it in order to get us thinking about 
cluster-observation data structure. In particular, we want to think about student-score data structures (aka,  person-
period data structures) for our research question. For other research questions, we may want to think about 
mother-child data structures or school-student data structures. 

The magic of multilevel regression modeling happens in the complex error term: we have one error term for the 
observation level and another error term for the cluster level. In our example, we will have student-level error and 
score-level error. The key to parsing the error will be the unconditional model:

iijij uREADINGL ++= εβ0

Model 0:

ijiij uREADINGL εβ ++= )( 0

Or, equivalently:
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Regression Perspective: ij Subscripts

Model 1:

iijijij uWAVEREADINGL +++= εββ 10

We use ij subscripts to distinguish our observation-level variables from our cluster-level variables. 
Observation-level variables get an ij subscript. Cluster-level variables get simply an i subscript.

In the problem at hand, we have scores (i.e., our observations) nested within students (i.e., our 
clusters). However, the system we are going to develop is flexible enough to handle any two-level 
nested structure. For example, we might have children (i.e., our observations) nested within 
mothers (i.e., our clusters), or we might have students (i.e., our observations) nested within 
schools (i.e., our clusters). 

WAVEij represents the value of the WAVE variable for the jth score of the ith student. E.g., for the 
2nd score of the 896th student, WAVE = 1.

READINGLij represents the value of the READINGL variable for the j
th score of the ith student. E.g., 

for the 2nd score of the 896th student, READINGL = 61.

Model 2:

iijiiiijij uLATINOBLACKASIANWAVEREADINGL ++++++= εβββββ 43210

ASIANi represents the value of the ASIAN variable for the ith student. E.g., for the 896th student, 
ASIAN = 0. (Note that since this is a student-level variable, there is no need to attach it to a particular score.)
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Regression Perspective: ij Subscripts (More Examples)

Model X:

iijijiij uGESTATIONMOMIQTBIRTHWEIGH ++++= εβββ 210

This is a study in which we ask whether smarter mother’s have heavier newborns, controlling for length of gestation. We do not want to 
ignore the fact that newborns are nested within mothers, because we have twins and other sibs in our study.

GESTATIONij represents the value of the GESTATION variable for the jth child of the ith mother. 
E.g., for the 3rd child of the 57th mother, GESTATION = 271.

MOMIQi represents the value of the MOMIQ variable for the ith mother. E.g., for the 57th mother, 
MOMIQ = 105. 

Model Y:

iijijiijij uTIOBLACKxBWRABWRATIOBLACKMATH +++++= εββββ 1210

This is a study in which we ask about the Black/White math achievement gap and whether it varies by the racial composition of schools.

BLACKij represents the value of the BLACK variable for the jth student of the ith school. E.g., for the 
83rd student of the 5th school, BLACK = 1.

BWRATIOi represents the value of the BWRATIO variable for the ith SCHOOL. E.g., for the 5th

school, BWRATIO = 0.75. 
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Person-Period Data Set Structure

Old Structure New Structure

Note that for most multilevel data, the cluster-observation data set structure is natural. Person-period data sets are the exception. For example, in a mother-child data 

set, every child will have a mother ID and a child ID, or in a school-student data set, every student will have a school ID and a student ID.

A person-period data set has one time slice per row, but the rows are grouped by an identifying variable and distinguished within the 
groups by an index variable. No information is lost when converting to person-period data sets.
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SPSS and Data Set Restructuring

Go to Data > Restructure 
and SPSS will walk you 
through all the steps.
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Regression Perspective: εij and ui Error Terms (Part I of III)

Now that we have one outcome, we can ask about the mean and variance of THE outcome.

εβ += 0READINGL

Model 0:
However, we know that there is a multilevel 
structure to our data and, consequently, to 
our outcome. We know that a portion of the 
variation in scores is attributable to the fact 
that some students are better readers than 
other students.  We also know that a portion 
of the variation in scores is attributable to 
the fact that students improved from the 8th

grade to the 10th grade. In other words, we 
have person-level variation and period-level 
variation. In still other words, we have 
student-level variation and score-level 
variation (where “score” refers to the 
differing scores for each student depending 
on wave).

Not Quite Right!

iijij uREADINGL ++= εβ0

Model 0: That’s Right!

εij represents the 
residual for the jth 
score of the ith 
student over and 
above ui, which 
represents the residual 
for the ith student. 
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Regression Perspective: εij and ui Error Terms (Part II of III)

iijij uREADINGL ++= εβ0

Model 0:

ijiij uREADINGL εβ ++= )( 0

MIXED READINGL

/PRINT=SOLUTION

/RANDOM INTERCEPT | SUBJECT(ID).

Command SPSS to fit an intercept-only model (i.e., unconditional model) 
that takes into consideration the multilevel structure of the data.

We are now touching on the distinction between random effects and 
fixed effects in the general linear model. Up until now, we have only 
dealt with fixed effects models. Now, we are dealing with a mixed 
model: part fixed, part random. But, let’s save a deep discussion of 
random effects for another day. (We are in deep enough already!)

Specify your outcome variable.

Specify your clustering variable.

Equivalent, “Random Intercepts” Model:

86.4 = 24.7 + 61.7
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Regression Perspective: εij and ui Error Terms (Part III of III)

iijij uREADINGL ++= εβ0

Model 0:

The intraclass correlation is the proportion of total variance attributable to the cluster level. When the intraclass 
correlation is extremely high, all the observations within each cluster are basically the same with respect to the 
outcome variable. When the intraclass correlation is extremely low, observations within each cluster are clustered 
together in name only since nothing is tying together their outcome values.

nCorrelatio Intraclass71.
7.617.24
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Whereas the  t-test and ANOVA uses the Pearson correlation, 
regression uses the intraclass correlation to account for the non-
independence (i.e., clustering) of observations.
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??? Guessing Intraclass Correlations ???

In studies of students nested within schools, what is the intraclass correlation? 
The answer is going to depend on our outcome. Reading scores? Emotional 
disorders? Community service? Self esteem? Locus of control? For giggles, 
suppose that our outcome has to do with school clothing, and our data include 
students clustered within schools. Below are two school-clothing studies, each 
with its own data set. Which of the two data sets will have the higher 
intraclass correlation?

Study 1 Study 2
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Regression Perspective: Fitting Our Final Model

MIXED READINGL WITH WAVE

/PRINT=SOLUTION

/FIXED=WAVE

/RANDOM INTERCEPT | SUBJECT(ID).

Command SPSS to fit a model (i.e., conditional model) that takes into 
consideration the multilevel structure of the data.

Specify your 
predictor variable(s).

Model 1:

iijijij uWAVEREADINGL +++= εββ 10

WAVEINGLDREA 8.32.48ˆ +=
Interpret your fitted multilevel regression model as you would interpret any fitted regression model. But, 
do so with more confidence because you have not ignored the independence assumption!

You may note that estimated difference between waves 0 and 1 and the associated standard error and  t-
value is identical to those from the paired samples t-test. We have come back full circle.

We can use all our 
MR modeling skills 
(controlling, 
interacting, and 
taxonomizing) to 
build this simple, 
one-predictor 
model into a fully-
fledged multiple 
regression model.
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Regression Perspective: Presenting Our Final Model

We present and interpret our final model just as we would any 
regression model, except we include our unconditional model 
(i.e., intercept-only model) as a baseline. From this baseline, we 
can compare cluster-level variances and observation-level 
variances.
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The pseudo-R2 statistic is a nice (but sometimes flawed) way to 
describe the goodness of fit. The true R2 statistic in the OLS 
regression to which we are accustomed describes the proportion 
of variance in the outcome that is predicted by the predictor(s).  
Now that there are two variances associated with the outcome, we
want two R2 statistics, one for each type of variation—cluster-level 
variation (i.e., between-cluster variation) and observation-level 
variation (i.e., within-cluster variation). However, we are no 
longer doing ordinary least squared regression (OLS). Instead of
fitting our model based on the least sum of squares, we are fitting 
our model based on the least -2 log likelihood. Therefore, our R2

statistic is not a true R2 statistic but a pseudo-R2 statistic. In a 
multilevel model, the pseudo-R2 statistic is prone to breaking 
down when we include only cluster-level variables or only 
observation-level variables. 

On average, in the population, students 
improve 3.8 points on the IRT scaled reading 
test from the 8th grade to the 10th grade. 
Based on a pseudo-R2 statistic of 0.30, WAVE 
predicts 30% of the within-student variation 
in IRT scales reading scores.
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Regression: Exploratory Data Analysis and Assumption Checking

Hitherto, we have neglect the crucial book ends to regression modeling, exploratory data analysis 
and assumption checking.  We can (and should!) use all the tools that we have learned in these 
regards, but twice over. Because we have two levels (the cluster-level and the observation-level), 
we want to explore each level and check the residuals association with each level.

Exploratory Data Analysis
• SPLASH, DOLMAS and ABORT for the cluster-
level data. Use the mean observation for each 
cluster.

•SPLASH, DOLMAS and ABORT for the 
observation-level data. Use each observation, 
but subtract away the mean observation from 
its respective cluster.

Assumption Checking
• Examine RVF plots using residuals from the 
cluster level, ui.

•Examine RVF plots using residuals from the 
observation level, εij.

*Obtaining mean observations for each cluster.

*Obtaining observations minus cluster mean.

This is not finished, but for now, you can find 
the SPSS code in this article:

http://www.upa.pdx.edu/IOA/newsom/mlrclass/ho_cent
ering%20in%20SPSS.pdf

*Obtaining cluster-level residuals.

*Obtaining observation-level residuals.

This is not finished, but for now, you can find 
the SPSS code in this article:

http://www.cmm.bristol.ac.uk/learning-
training/multilevel-m-software/reviewspss.pdf
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t-tests, ANOVAs, Regressions, Oh My!

Question: If t-tests, ANOVAs and regressions yield identical results, why ever choose 
the complex ANOVA or the even more complex regression over the simple t-test? 

Answer: FLEXIBILITY

t-test ANOVA Regression
Once Repeated Measures Yes Yes Yes

Multiply Repeated Measures No Yes Yes

Categorical Predictors
(with or without interactions)

No Yes Yes

Continuous Predictors
(without interactions)

No Yes Yes

Continuous Predictors
(with interactions)

No No Yes

Any Cluster-Observation Data
(e.g., students within schools            
or children within mothers)  

No No Yes!

Multilevel regression modeling is known by many names, including “mixed modeling,” “nested 
modeling” and “hierarchical linear modeling (HLM).” Unfortunately, “HLM” is not only the acronym 
for hierarchical linear modeling, but it is also the name of proprietary software. You can use HLM 
(the proprietary software) to do HLM, but you can do HLM in most software packages, including SPSS.

There are an infinite number 
of error structures that we 

can specify in multilevel 
regression modeling, and we 
touched on the most basic. 
Consider scores nested within 
students nested within 

various teachers nested 
within schools.


